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Wavetable can now be fully controlled using MPE controllers. Each track shows a CPU meter with six rectangles that light up to indicate the relative impact of that track on the CPU level of the current Live Set. When editing multiple MIDI clips at once, a connected Push device now follows all highlight changes of tracks/scenes, and the focus on the
corresponding track. Focus Mode can be toggled via the N keyboard shortcut. The command is available in the Create menu, and the context menu of Arrangement clips, or via the CTRL-ALT-F(Win) / CMD-ALT-F(Mac) keyboard shortcut. If Focus Mode is enabled in multi-clip editing, only the foreground clip’s key and scale will be updated in Live. In
Session and Arrangement View, the Monitor radio buttons now have a default state that can be restored. The Randomize button allows randomizing velocity/probability values for selected notes (or notes with selected markers), depending on the focused lane. Pressing the Rand button in the title bar of a Rack randomizes the values of mapped Macro
Controls. The Slide, Pressure, Velocity, and Release Velocity dimensions are displayed inside new expression lanes below the MIDI Note Editor. Chorus-Ensemble (see 24.8) is a new audio effect featuring two different chorus modes and a vibrato mode for creating pitch variation. The Follow Action Chance slider now displays a split triangle instead of
just a black bar when it is showing multiple different values. The Velocity and Chance Editor lanes can be shown or hidden via the lane selector toggle buttons at the left. It shows a flat list of all Grooves from the Core Library as well as the User Library. In the first captured MIDI clip (in an empty set with the transport stopped), if the detected loop is
eight bars or less, the first played note is considered the start of the loop. Live’s Status Bar will now indicate when an update for Live is being downloaded. This button is disabled by default, and can be toggled using the Shift-Enter keyboard shortcut. Error reporting in the Max Window is more consistent. You can also drag samples from your library
and use comping as a creative sample-chopping tool. Alternatively, the CPU meter can also be switched off entirely. In Session View, new captured clips now use the Adaptive Grid: Narrow setting instead of Fixed Grid: 1/16. Degree symbol icons (Push 1) or bullet point icons (Push 2) are used to differentiate the Rack from the device. The Show Tempo
Follower Toggle switch shows/hides the Follow button in the Control Bar. 1.2.21 Setup Improvements As of version 11.1, Live is natively supported on Apple silicon computers. By default, Live will not display the Current level; it must be enabled from the drop-down menu of the meter. When a Rack contains a parameter mapped to one of the new
Macro Controls (e.g., Macro 9-16), the additional Macro Control parameters will appear in a new device within the Rack. This effort continues even as you read these lines... Live will then create and organize individual takes from this recorded material, allowing you to piece your favorite parts together. Link functions have been added to the Max for
Live API. Clip Volume is now called Clip Gain in the Envelope tab’s Device/Control choosers, and in the undo history. 1.2.5 Comping Introduced comping (see Chapter 18) in the Arrangement View. Added a Grid Line Intensity slider to the Look/Feel Preferences, allowing for more pronounced or dimmed appearance of grid lines in the Arrangement and
Detail Views. Underneath the lane selector toggle buttons, a triangular toggle button allows showing/hiding all enabled lanes at once. We hope you enjoy using Live and that it enhances your creative process. When using the command a second time (without changing the time selection), Live then zooms vertically as well. Clicking this entry cancels
the launch of any previously triggered scene. The Velocity and Chance Editor lanes can be resized at once by dragging the split line between the lanes and the MIDI Note Editor. 1.2.19 Rack and Macro Control Improvements The maximum number of available Macro Controls (see 20.1.2) in Live has been doubled to 16. When Push’s In Key/Chromatic
is set to In Key Mode, and the selected MIDI clip has Scale Mode enabled, selecting a scale in Live will change the pad layout on Push. Linked-track editing makes it possible to use comping workflows and other phase-locked editing operations on multiple tracks at once. 1.2.15 Multi-clip Editing The new Focus button enables Focus Mode (see 10.5.1),
which allows editing the current foreground clip only. The lowest dot in a meter lights up in a blue color if per-note controller changes pass that meter. This palette makes clips and tracks easier to tell apart with a deuteranopia, protanopia or tritanopia color vision deficiency. By default, key tracks belonging to the selected scale are highlighted in the
MIDI Note Editor, and the root note is indicated by a prominent highlight in the piano roll. 1.2.18 Additional Push Improvements Added a Pressure switch to Push 2’s Setup Menu that allows toggling between monophonic and polyphonic aftertouch when playing melodic instruments. An error message will be displayed in the status bar if an auto-
update cannot be downloaded. Introduced linked-track editing (see 6.13) in the Arrangement View. When the In/Out section is expanded, you can press the Delete key to reset the Monitor radio buttons to the default (Off for audio tracks and Auto for MIDI tracks). All Max for Live devices have been moved inside the application bundle (previously,
they lived in the Core Library), to ensure that using Collect All and Save will not create redundant copies of the devices. 1.2.7 Device Additions and Improvements Hybrid Reverb (see 24.25) is a new audio effect which allows blending a convolution reverb with a number of reverb algorithms. A Grooves label (see Chapter 13) has also been added.
Added a Reduced Automatic Colors toggle to the Look/Feel Preferences, which uses a reduced color palette when assigning colors to clips and tracks. 1.2.13 MIDI Note Editing A new Chance Editor (see 10.4.9) allows setting the probability of a MIDI note occurring in a playing clip. Dragging the left edge of the Master track’s title header reveals two
new controls, which allow assigning a tempo or time signature to a scene. A Tempo Follower section has been added to Live’s Preferences in the Link, Tempo, MIDI tab. Upon using the command a third time, the Arrangement returns to the first vertical zoom state. Please make sure you have a Live Lite serial number before downloading. 1.2.16 Push
Device Visualizations On Push 2, the Hybrid Reverb parameter banks Algorithm 1 and Algorithm 2 have been renamed. It is now possible to change the note selection in the MIDI Note Editor using CTRL(Win) or ALT(Mac) and the up and down arrow keys. The Pitch control now has a dial control for transposing in semitones, and a text slider control
for fine-tune in cents (previously named Transpose/Detune). Spectral Time (see 24.40) is a new audio effect that combines time freezing and spectral delay effects in a single inspiring device. A new Show/Hide Macro Variations view selector button in Racks opens a view that allows storing the state of the Macro Controls as a variation preset via the
“New” button. An update to the Softtube libraries may cause subtle sound changes in the Amp and Cabinet audio effects. Selected automation lanes or take lanes can be resized vertically by pressing ALT-+ or ALT--, or by pressing ALT while using the mousewheel/pinch gesture. 1.2.17 Push MIDI Clip Mode When Push’s In Key/Chromatic is set to In
Key Mode, and the selected MIDI clip has Scale Mode enabled, selecting a scale on Push will update that clip’s scale in Live. The Invert button is now enabled in the Notes tab when at least one note is selected, and it is possible to invert selected notes from multiple clips at the same time. The Cytomic Filters, which are used in the Wavetable, Echo,
Simpler, Sampler, Operator, and Auto Filter devices, have been updated and improved in stability, sound and performance. You can use the left arrow key to navigate from an automation lane or take lane to the main track, this will fold the lanes as well. New + and - view selector buttons in Racks allow setting how many Macro Controls are shown or
hidden. 1.2.8 Follow Actions Follow Actions can now be assigned to scenes via the new Scene View. This is particularly useful when playing a rhythmical sample with a single MIDI note. There can be multiple instances of linked tracks in a Set, however each track can only belong to one of these instances. MPE Control is a new Max for Live MIDI
effect that can be used to shape and transform incoming MPE modulation for Pressure (polyphonic aftertouch, Slide (per-note Y-Axis) and Pitch (per-note pitch bend). When using the Zoom to Time Selection command in the Arrangement, Live now only zooms horizontally at first. Redux (see 24.33) now has new parameters that can be used to create a
wider range of sounds, from harsh distortion to digital and aliasing artifacts, through to warm and fat 8-bit sounds. The lane header selection can also be extended using Shift and the up and down arrow keys. 1.2.14 MPE Support and Editing Added support for MIDI Polyphonic Expression, also known as MPE (see Chapter 11). Dragging a note’s
probability marker up and down changes the probability value between 0-100%. Wavetable has a new Hi-Quality right-click(Win) / CTRL-click(Mac) context menu option (see 26.10.9). It is now also possible to use MPE/Push 2’s Pressure mode to modulate individual notes in Sampler and Simpler. Added a new MIDI Envelope Auto-Reset entry to the
Options menu. The Lite serial number is issued when registering your hardware with the manufacturer, or is included with the device packaging itself.If you're new to Live, these videos will show you everything you need to know to get started.Check out more Learn Live videos Live is the result of musicians wanting a better way to create, produce
and perform music using a computer. The CPU meter (see 33.1.1) drop-down menu now can be customized to display both the Average or Current CPU usage levels, only the Average level or only the Current level. The Groove Pool now opens automatically when loading a groove file from the browser by double-clicking or pressing the Enter key,
adding a groove to the Groove Pool, or extracting grooves. Spectral Resonator (see 24.39) is a new audio effect based on spectral processing that uses spectral resonances and pitched overtones to add tonal character to any audio source. When editing multiple clips with different key and scale settings, any foreground clip with Scale Mode enabled
now updates the global settings that are used to initialize the next created clips, as well as Push’s key and scale. Newly-created MIDI clips inherit the previously edited or viewed clip scale, even if they have Scale Mode disabled. in fact, a new, improved Live version might already be available for download! Please check your ableton.com account now*
or choose the Check for Updates command from the Help menu. The Expression Control device now allows assigning an additional parameter as a mapping target. Time selection interactions, note selection interactions, and new note editing options have been added to multi-clip editing. Comping makes it possible to pick the best moments of each
recorded performance, and combine them into a composite track. If you own any previous version of Live Lite, you can upgrade for free.End User License AgreementLive Lite serial numbers are included with various hardware devices and apps - find out more here. 1.2 What’s New in Live 11 1.2.1 Arrangement View Improvements A new Create
Crossfades On Clip Edges command creates four-millisecond crossfades on clip edges. You can also use the left arrow key to navigate from tracks in a group to the main Group Track. If no markers are selected, values for all notes will be randomized. ReWire support has been removed. When enabled, certain MIDI control message types that are not
automated for a given clip will automatically reset at the start of a new clip. Sampler and Simpler now support MPE. The Reverse and Edit buttons are now positioned next to each other. It is possible to change the selection of automation and take lane headers using the up and down arrow keys. Keep in mind Live Lite only comes with certain devices
and a serial cannot be issued without a qualifying hardware purchase. If the selected track is armed, the command is replaced with Disarm Track. When multiple audio clips with different Clip Gain values are selected, the value range is shown with split triangle handles on the Clip Gain slider. Updated the notification style for scenes, and updated the
scene name visualization to include the absolute position, tempo and time signature on Push. Selected tracks and automation lanes can be folded/unfolded using the left and right arrow keys. Scene numbers are now displayed in a new column in the Master track. Loops are now visible and editable via mouse interactions. It shows template Live Sets
from factory packs (including the Core Library), the User Library, and other Project folders. In) chooser allows choosing the channel from which the tempo will be tracked, and displays a level meter for each channel. The Saw Up and Saw Down icons for Sampler’s LFO waveforms on Push 2 now appear as expected. Added an Arm Track command to
the Edit menu. Four new theme colors are available in Max for Live. The Overload Indicator (previously named the “Disk Overload” indicator) in the Control Bar has been redesigned, and will light up if a CPU overload has occurred. In the Record/Warp/Launch tab of Live’s Preferences, a new MIDI Note Drawing section contains a Draw Mode with
Pitch Lock option. 1.2.9 Interface Improvements Live’s Themes have been redesigned to provide much greater contrast. An Input Channel (Ext. These values can be modified using a new slider control. Shaper MIDI (see 28.3.4) is a new Max for Live MIDI effect that uses multi-breakpoint envelopes to generate mappable modulation data. When
enabled, drawing MIDI notes is constrained to one single key track (or pitch) at a time, while holding the ALT key allows freehand melodic drawing. Using Wavetable with Hi-Quality mode off can save up to 25% CPU compared to having it enabled. Updated the appearance of the UI in the Tension (see 26.9), Electric (see 26.3), Corpus (see 24.10), and
Collision (see 26.2) devices. Your Ableton Team. It is now possible to rename multiple selected clips at once, via the Rename command in the right-click(Win) / CTRL-click(Mac) context menu, Edit menu, or by using the CTRL-R (Win) / CMD-R (Mac) keyboard shortcut. When Push 2’s Pressure mode is set to Poly, the Repeat button now produces notes
at full velocity when Accent is enabled. command, they are automatically self-contained in the same way as Sets that use the File Manager’s Collect and Save function. Added an MPE Settings dialog box to the I/O section of Live’s mixer (see 11.6). Push 2 and MIDI controllers sending polyphonic aftertouch can be used with plug-in devices that support
polyphonic aftertouch. Reorganized the Edit menu for improved usability and accessibility, and added a new Solo/Unsolo Track entry. CPU overload notifications can be disabled in the Control Bar via the CPU Overload Indication entry in the Overload indicator’s context menu. You can move automation lanes and take lanes using CTRL(Win) /
CMD(Mac) and the up and down arrow keys. When Sets are saved with the File menu’s Save Live Set as Template... Phaser-Flanger (see 24.32) is a new audio effect that combines the functionalities of the Phaser and Flanger devices into one, as separate effect modes. When viewing and expanding Live Sets in the browser, you will see a new Devices
icon for device chains on a track that contain at least one device. Updated some parameter names for the Chorus-Ensemble device on Push 2. The Audio tab’s Reverse button now shows an icon instead of text. Added a Cancel Scene Launch entry to the Master track’s right-click(Win) / CTRL-click(Mac) context menu. Added support for keyboard
shortcuts on French keyboard layouts for macOS versions 10.14 and older. The audio engine can now be turned on or off via a new Audio Engine On entry in the Options menu, or using the CTRL-ALT-Shift-E(Win) / { CMD]ALT-Shift-E(Mac) keyboard shortcut. 1.2.20 Session View Improvements Selecting a scene (or multiple scenes) opens the new
Scene View (see 7.2.2), which allows editing the selected scene’s tempo, time signature and Follow Actions. Pressing Tab/Shift-Tab while renaming an Arrangement clip selects the next/previous clip on the same track or take lane. The Overload Indicator is disabled by default for new Live 11 installations. Follow Actions can be activated or deactivated
using the selected clip/scene’s Follow Action button. You can unfold more than one folder at once by holding CTRL(Win) / CMD(Mac). When disabled, no Follow Actions will occur in the Live Set. Shifter (see 24.38) is a new audio effect designed for pitch shifting, frequency shifting, and ring modulation. An Enable Follow Actions Globally button has
been added next to the Back to Arrangement button in the Session View. When Max fails to load, an error message will be displayed that contains a link to a Knowledge Base article that explains potential causes for the issue and steps to take to resolve it. Devices in the Audio Effects label are now grouped into folders. A great deal of effort has been
put into making Live easy and fun to use, yet at the same time capable of helping you create music with unlimited depth and sophistication. You can record multiple takes of a musical performance without stopping recording. You can use the left and right arrow keys to navigate radio buttons anywhere in Live. Align Delay (see 28.2.1) is a new Max for
Live audio effect that delays incoming signals by samples, milliseconds, or meters/feet. If you are navigating radio buttons on a device that is inside of a Rack with the left and right arrow keys, you can get back to moving between devices in the Rack using the left and right arrow keys by hitting the ESC key. You can solo tracks with the S key and arm
tracks with the C key when take lane headers or automation lane headers are selected. Updated the bundled Max build to version 8.2.1. Added support for MPE input to/output from Max for Live devices. As of 11.1, the Cytomic filters (particularly the MS2 and SMP options) might deviate in sound compared to previous Live versions, especially when
driven hard. Live now makes better use of screen space when editing clips. Also some parameters for Hybrid Reverb have been rearranged for easier navigation. The browser receives focus when opened via the CTRL-ALT-B(Win) / CMD-ALT-B (Mac) keyboard shortcut. It is now possible to arm selected tracks using the C shortcut key. Pressing ALT-1
switches to the Audio/Notes tab, pressing ALT-2 switches to the Envelopes tab, and, when a MIDI clip is selected, pressing ALT3 switches to the Note Expression tab. Select “Arrange Clip View Panels Automatically” from the View menu to enable this option. Ableton’s official Max for Live devices are now listed within the Audio Effects, MIDI Effects,
and Instruments labels. This option is also accessible via the Edit menu option Return to Default. In the Notes tab, a Velocity Range slider (see 10.4.8) allows assigning velocity ranges to selected notes (or all notes in a single clip, if none are selected). MIDI track meters now indicate MPE per-note controller changes. Any tracks in the Arrangement
View can now be linked so that their content can be edited simultaneously. Keyboard shortcuts that have numbers can be accessed without having to press Shift to access the number keys. It is now possible to see and edit a velocity range, from which a velocity value is selected when a note is played. Clip Follow Actions will continue to run when a
scene Follow Action is created or scheduled, however scene Follow Actions take precedence when triggered. To avoid incompatibilities, you will be asked to save Live Sets created with an older version of Live as a new file in Live 11.1. 1.2.22 Tempo Follower Introduced Tempo Follower (see 32.2), which adapts Live’s tempo to stay in time with a
drummer or another rhythmic audio source. Clicking on the new Show/Hide CPU Meter Section selector in the Session View’s Mixer Section will open a per-track CPU metering section. Clip View properties (see 8.1) can be arranged vertically by moving the mouse cursor to the left from the Clip View panel edge next to the Sample Editor/MIDI Note
Editor. Plug-in devices that have MIDI outs and that have MPE enabled can now output MPE. The Audio tab’s Clip Gain control has been changed back to a vertical slider, and it has been repositioned above the Transpose controls. Clip View properties can also be arranged automatically, which switches between the horizontal and vertical views
depending on the height of the Clip View area. 1.2.12 MIDI Clip Scales A new Scale Mode (see 8.1.9) can be enabled/disabled via the Scale button in the Clip tab of MIDI clips. or Save Live Set as Default Set... When a note is moved, its expression envelopes will move along with it. 1.2.2 Browser Improvements A Templates label (see 5.5.4) has been
added to the browser’s Categories. If multiple tracks are selected, the command appears as Arm Tracks. Follow Action Chance A and Chance B values are now represented as percentages that sum to 100%. When only one note is played in the first captured MIDI clip (in an empty set with the transport stopped), the loop boundaries are set to the note
start and end, and the tempo is accordingly calculated, resulting in a one, two, four, or eight bar loop. Once it is downloaded, the Status Bar will state that Live must be restarted in order to apply the update. The number of visible Macro Controls in Instrument Racks can now be controlled from a Max for Live device or a control surface. Added MPE to
Capture MIDI.
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